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WARNING: Be careful when using your
camera and its accessories. Always be

A caution of your surroundings to avoid injuring
yourself and others.

Make sure to follow all local laws including all
privacy laws which may restrict recording in
certain areas.
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Meeting Your F7N Meeting Your F7N
e ————

3. Up / WIFIButton
1. Screen 4. Mode / Confirm Button

2. GPS Mount 5. Down / Button

10. Status Light

6. Power Button ()

7. Micro SD™ Card Slot
12. Lens




Meeting Your F7N
O  — 1

8. AV-in

9. USB Power Slot

11.  Reset Button

F7N Power Tools

1. Cig Charger m—
{No Battery Protection)
SEE PAGE 5

2. Hardwire Kit
(Parking Mode Needed)
(Extra charge)



Setting Up Your Camera
O ———

INTRO TO F7N
Trustful Dashcam that guarding each ridding of yours.

UPDATING YOUR CAMERA’S SOFTWARE

To get the latest features and best performance from your
camera, make sure it's using the most current software.
1.Visit https://www.redtigercam.com/pages/firmware-
1/update.

2. Update guide

POP-UP: Keep your SD card in good condition by
reformatting it regularly. This will erase all of your
media, so be sure to save it first.

1. Press M button and entre Settings

2. Press UP button > Format > OK

WARNING: This product is for DC 12v / 24v
only.

Setting Up Your Camera
e —
SD CARD

With your camera off, insert the SD card into the card
slot with the label facing the back of your camera.

You can eject the card by pressing it into the slot with
your fingernail.

WIRING SET UP
Connect your camera to a Cig charger using the
included cig charge cable.

SD CARD

You'll need a micro SD card (sold separately) to save
your videos and photos. Use a U3 Class 10 SD™ Card
dedicated or your camera may malfunction.

SD cards can degrade over time and affect your
camera’s ability to save your media. Try swapping out
an older card for a new one if you're having any
problems.

POP-UP: Want to know what software version you're using?
Here’s where you can find out.

1. Press M button and entre Settings

2. Press UP button > Version



Setting Up Your Camera

POWERING ON
Short press (') button to turn on your F7N.

POWERING OFF
Press and hold () button or 3 seconds to turn it of.

Playing Back Your Media

CHOOSE YOUR MODE
Press M button to entre Recording>Playback>Setting.
Video mode will be auto-select when power on.

PLAYBACK
F >>Front Camera R >> Rear Camera

Nomal

Nomal

POP-UP:

POP-UP:
Short press d) > Front and Rear View > Front Only > Rear
Only > Lock Screen > Screen Display Off

>"AUto record in 30s none action

> Long press UP to Turn On WiFi

> Short press up to lock video

> Short press DOWN to Capture a movement
> Long press down to stop/play recording



Playing Back Your Media

PALYBACK
Short press M button to see your records.

When select a record > Long press M button
3s to edit your records.

O & 4

Deletell

oK|

POP-UP: Urgent Locked video will be created by
camera sensed a collision or vibration (G-sensor on).

It can’t be auto-recover but only format to save the
important moment.

Select Lock Video to unlock and delete.

You can turn off G-sensor to avoid Locked Records.

Customizing Your F7N

SETTINGS
Short press to entre Settings menu.

Resolution > 2160P @30FPS
> 1440P @60FPS
> 1080P @120FPS

v

Audio Sound Recording ON / OFF
Date Stamp > Stamp ON/OFF

Loop recording > 1/3/5mins

G-sensor > Off / Low / Medium / High
Fatigue Driving > A Reminder Will be Made During
Speed Stamp 1h/2h /3h/4h/ off
GPS Stamp > Stamp ON/OFF

> Stamp ON/PFF



Customizing Your F7N Customizing Your F7N
- : C‘

[
SETTINGS SETTINGS
Next page Next page

O N °

RearcamFlip Mirror Flip

B & O

Date/Time TimeZone ~ DST

® o~

Language TimeFormat V|

¢ m

34 ClickTone  Screen..  Parking.. Formatre

Date / Time > Up Date With GPS
Spezd Ut > BURY A Time Zone > Choose Your Time Zone
GPS Info > Display GPS signal strength DST > Daylight Saving Time ON / OFF
Rear Cam Flip > Vertical Flip Your Rear View Frequency > 60HZ / 50HZ
Mirror Flip > Horizontal Flip Your Front View Click Tone > ON/ Mute
ahky > AERCEEDIET RGP Screen Saver > Screen Go Off After
Wii > WiFi ON/ OFF [Ceii20si2es
Language > Choose Your Prefer Language faihinolbicde @s=nsollinatanss

Format-Reminder > Remind to Clear Data / Prompt

Time Format > 12h/24h 1
formatting



Customizing Your F7N

e —

SETTINGS
Next page

“E @ o 0 “

Format  Cardspeed DefaultSetting Version

SD Card Format > Clear SD card data

Card-Speed > Card Speed Detection
Default Setting > Reset All Settings
Version > Software Version

Parking Mode ( Optional )

PREPARE YOUR HARDWIRE KIT

Since we considered some customers have
no need of Parking Mode, there’s no hardwire
kit included in your packages. You could
refer this line of words to contact us to get
a free hardwire kit.

GETTING TO KNOW YORU HARDWIRE KIT

Features:

> Low Voltage Protection
> Multi Input Power

> Universal Compatibility
> Length: 11.5ft

“_'_L\ I JJ

POP-UP: In order to a Clean, Smooth,
Comfortable using experience, we suggest
you format your SD card once a month.

10

disable Voltage Protection and

WARNING: Wrong connection may
A damage your car.



Parking Mode ( Optional )

INSTALL YOU HARDWIRE KIT

Red wire >>ACC  >>> power off along the car
Yellow wire >> B+ >>> never power off
Black wire >> Ground e.g. screw

Engine key

Accessory code (red)

Battery cord (yellow)

Earth cord (black)
battery Connect to metal part of the fuse
box (Negative pole of power supply)

POP-UP: You could usually find your fuse box under the
trunk or steering device.

You could cut the head of wires and connect it to your
fuse directly if your fuses is small.

11

Parking Mode ( Optional )

SELECT PARKING MODE
Enter Parking Mode In Settings

Setting >> Parking Mode

>> off / G-sensor / Time-Lapse 12h / Time-Lapse 24h /
Time-Lapse 48h

G-SENSOR

> Car off

>“ACC disconnected “ pop-up

> Collision or vibration be detected

> An Unerasable record will be created in Lock
space

TIME-LAPSE

> Select 12h / 24h/ 48h

A Record will be created in 1 fps during your parking time
1 min = actual 12 mins

Collision or vibration be detected

An Unerasable record will be created in Lock space

POP-UP: 1 fps = 1 image during 1 second.
G-sensor could be activated by a deceleration zone.



Parking Mode ( Optional )

WRONG INSTALLED

Connection Driving
== ACC
B+ ON

== Ground

== ACC
No connection o
= Ground

== ACC
ACC ON
= Ground

-_—
ACC OFF
=== No connection

=== No connection
Any power OFF
== Ground

—_— g
ACC ON
= Ground

Parking

ParkingMode

OFF

OFF

OFF

OFF

OFF

Right

Wrong

Wrong

Wrong

Wrong

Wrong

Parking Mode ( Optional )

PARTICULAR WRONG CONNECTION

Connection Driving Parking
- g
B+ ON Always On

== Ground

> The camera will run ParkingMode normally, but
your car battery will be ran out under this
connection.

> The ParkingMode will normal working in screen
off status. Unless there is a collision or vibration
triggered G-Sensor.

> Please check if your camera working after
15mins your car is off.



Connect to the Redtiger App

DOWNLOAD APP

1. Download our App from:
https://www.redtigercam.com/pages/app

2. Scan QR Code from your F7N

3. Download from Apple APP Store or Google Play Store

Teleport to WiFi operation:
https:/fyoutu.be/_NgPEb_G14c

Connect to the Redtiger App

CONNECT YOUR F7N

° )

Wi-Fi

WiFi Password: 12345678

> Connect Only This Time

POP-UP: This is to avoid series connection
between different device.

Some device may prompt that the software
contains virus, you could run the installation
as an administrator to download App.



Connect to the Redtiger App

ENJOY REMOTE CONTROL

v

Horizontal Flip

v

Full Screen Display

v

F /R View switch
> Mute

v

Real-Time Speed
GPS Info

v

o
v

PlayBack

08 > Stop / Start Record

v

Photo Taking

) B o @J > Settings
3

Connect to the Redtiger App

Loop Record Opsions

Vidoo Watermark. L )
Colision sensing

Sooed Uit

[T

Time-apse Vidoo Ourstion

Camas angusge

WiiName

s

[ B e =5
b Camera Setings < Camers Settings
B s — =

Cofsion Sensing

Speedunit

T lagas ideo Ou

WeFipassmord

Fammare Vrsion

-

> Enjoyed Most of Functions on

Your phone

e
=




GPS Player (PC)

—_——————————

DOWNLOAD GPS PLAYER

Download our GPS Player from website:
https://iwww.redtigercam.com/pages/gps-player

Transfer your record to

computer
s D)
o>

 — |

Drag in GPS Player




GPS Player (PC)

e —
USE YOUR GPS PLAYER

1 Footage Track

| S—

File' Name

oEAmA AAA.

Choose to see your Front/ Rear
View

See your Speed and
Location



GPS Player ( PC)
e I — |

USE YOUR GPS PLAYER

Watching Front & Rear at the same time

Video layback mode >
Video playback speed >

Language
wap

Speedunit
Trackkiog
AutoPlayNext

Front \ ﬁ

Folder




Mount your camera Maintenance
e —

HOW TO MOUNT YOUR CAMERA MAINTEN YOUR CAMEAR

Do not directly plug and unplug the cable or SD
card, please perform related operations after
camera off.

We do not encourage you connection your camera
with other hardwire kit, but if you insist to do this,
please have a look of those lower than 6V and
higher than 2.5A.

Do not expose to the sun for a long time is the
best, camera will heat on during its working, any
damaged by high temperature will be added to 1
year free replacement warranty.

Teleport to F7N & Rear cam Mounting:
> https://youtu.be/dS1YN7Zry0




Trouble Shooting

WIFI CONNECTION GOES WRONNG

Connection Prepare

> Mobile data / VPN is off

> 16 ft less close to your F7N

> Only allowed 1 device connection

Connection Notice
> WiFi password: 12345678
> Connect only this time

OTHER PROBLEM

Won’t enter Parking Mode

> Hardwire kit needed

> “ACC disconnected” pop up, then entre Parking
Mode automatically

> Blue light on + Red light flash

Camera always on after Car turned down
> Wrong connection of Red wire and Yellow wire
> Please connect red wire with ignition fuse

Mass Storage
> Use USB cable with Data transfer function,
please use USB cable without transfer function

Trouble Shooting

OTHER PROBLEM

Screen Resolution
> 4K = 2160P = 38402160
> 2.5K = 1440P = 25601440

Over Heat
> Camera could working -4°F- 150°F

RECEIVED DEAD CAMERA ?
Use USB cable to connect your camera with
computer and check if the screen turn on

> If not, please unplug sd card and use a pin
and press the Reset button at the bottom of
camera

> Reconnect your camera and press ()



Trouble Shooting
e ——
ULTIMATE SOLUTION
> Use different charging ways to see if the camera work.
> Use a pin or needle to press the reset button on the bottom of dashcam.
> Unplug every connection of camera.
> Plug micro USB charger to see if the camera working. If not, please use your personal USB charge and check again.
> Check your SD card is U3 Class10, if not, please change or leave message to us to get it.
> Plug SD card and see if the camera working, if not, please download the latest firmware to solve it.

Please download our latest firmware to upgrade your machine: https://www.redtigercam.com/pages/firmware-1

The upgrade steps are:

> Download the firmware to the computer.

> Copy the firmware called "FWQ70A" to the root directory of the SD card.

> Insert the SD card into the machine, then insert the power cord and short press the power button (do not turn off the power
during this process )

> During the upgrade process, the blue light is always on and the red light is flashing. After the upgrade is completed, the machine
will automatically turn on. i.e. done. You can refer to this video to upgrade: https://youtu.be/IMz1g309SPE.

> If the method above didn’t solve your problem, feel free to contact us and please leave current address
which is needed if the camera needs to be replaced later.

»  This solution could be dealing with multiple problems > Won’t turn on > Restart itself > SD card error
> Can’t auto recover > Can’t playback

20



Customer Service

WORDS FROM HEART

ince our Eroducts are related to the safety of customers, we are committed to product quality and high-quality after-sales,
we want to achieve the best product quality.

In view of no product is flawless, we sincerely believe the true measure of the company’s character is what it does *after* its
product does not meet expectations, we feel sorry for those customers, but deeply grateful for them to make us one more step
close to your most trustful auto-mobile after-market brand.

We are willing to provide 1 month free return for your product, 1 year limited warranty, and lifetime technical support. Your
product is guaranteed to be free of defects in materials and products from the date of purchase. In addition, you can also
exchange your 1 year old product for a discounted price by contacting us online.

Behold the motif of complexity to us, simplicity to others, it's such a pleasure to listen to your advice, and we will take your
problem from here.

Redtiger Customer Service Team

Email

Mirror Dash Cam

Email: support@redtigercam.com Customer Phone Service:
Mini Dash Cam +1 888 966 8028

Email: help@redtigercam.com Business Day, Mon-Fri
Business Cooperation or Others Email: 6 AM-12 AM, 1 PM-8 PM
contact@redtigercam.com EST (GMT-4)

21



Product Information

BASIC INFO OF YOUR CAMERA

Model

Display

Power

Aperture

Battery

Video Format
Loop recording
Recording method
Screen View

Resolution

GPS

Audio

22

>F7N G-sensor
>3.16 inch IPS Micro SD card
> 12V/24V Record photo
>1.5

Temperature

> Super capacitor
Warranty period
> Video:MP4 Still image: JPG
> 1/3/5mins
> Normal recording/Emergency recording

> Front & Rear view/Front view/Rearview

> Front 3840*2160P,Front 2560*1440P
Front 2160P+Rear 1080P,Front 1440 P+Rear1080P

>Yes

> Support sound recording and playback

> 3 Axis G-sensor
> Micro SD 32GB-256GB

> Main body display / Computer
/ Smartphone

>-4°F-150°F

>1Year
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Redtiger

Always go-to dash cam

About Us

In an automobile-interconnection era,
everything about charm journey is within the reach of eyes.

Product and service are the foundation of Redtiger. We have an expert research and
development team of "self-driving experts per capita”.
Based on the personal needs of users,
we use technology to drive product innovation.

In the future, we will continue to explore the boundaries of tech to open up
a broader vision for driving.
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Incontrare il tuo F7N

1. Schermo

2. Supporto GPS

10. Luce di stato

12. Lente

25

Utensili Elettrici F7N

3. Pulsante Su / WIFI
4. Pulsante Modalita / di conferma

5. Giu / Pulsante

6. Pulsante di accensione Q)

7. Slot per schede Micro SD™



Incontrare il tuo F7N Utensili Elettrici F7N

Di .
9. Slot di alimentazione USB

26

1
\l
i 11. Pulsante di ripristino M

1. Caricatore Cig .):,
( Nessuna protezione della
batteria) VEDI PAGINA 5

2. Kit hardwire

( Modalita di parcheggio
necessaria)

(A pagamento )



Configurazione della telecamera
O ——
INTRODUZIONE A F7N

Dashcam affidabile che protegge ogni tua guida.

AGGIORNAMENTO DEL SOFTWARE DELLA

Telecamera Per ottenere le funzionalita piu recenti e le
migliori prestazioni dalla telecamera, assicurarsi che stia
utilizzando il software piu recente.

1.Visita https://www.redtigercam.com/pages/firmware-1/
update.

2. Guida all' aggiornamento

POP-UP: Mantieni la tua scheda SD in buone condizioni
riformattandola regolarmente. Questo cancellera tutti i tuoi
file multimediali, quindi assicurati di salvarli prima.

1. Premere il pulsante M e inserire Impostazioni

2.Premere il pulsante UP > Formattare> OK

ATTENZIONE: Questo prodotto & solo per DC
12v/ 24v.

27

Configurazione della telecamera
e ——— ———— |
INTRODUZIONE A F7N

Con la telecamera spenta, inserire la scheda SD nello
slot per schede con |' etichetta rivolta verso il retro della
telecamera.

Puoi espellere la scheda premendola nello slot con I'
unghia.

SCHEDA SD

CONFIGURAZIONE DEL CABLAGGIO

Collegare la telecamera a un caricabatterie Cig utilizzando
il cavo di ricarica cig incluso.

SCHEDA SD

Avrai bisogno di una scheda micro SD ( venduta
separatamente ) per salvare i tuoi video e le tue foto.
Utilizzare una scheda SD™ U3 Classe 10 dedicata o la
telecamera potrebbe non funzionare correttamente.

Le schede SD possono degradarsi nel tempo e influire
sulla capacita della telecamera di salvare i file multimediali.
Prova a sostituire una carta precedente con una nuova in
caso di problemi.

POP-UP: Vuoi sapere quale versione del software stai
utilizzando?

Ecco dove puoi scoprirlo.

1. Premere il pulsante M e inserire Impostazioni

2.Premere il pulsante UP( SU ) > Versione



Configurazione della telecamera

ACCENSIONE
Premere brevemente () il pul per dere I'F7N.

b ) 0 o=@

SPEGNIMENTO
Tieni premuto (1) il pulsante o 3 secondi per spegnerlo.

.-
Sk

POPUP:

Premere brevemente L') > Vista anteriore e posteriore >
Solo anteriore > Solo posteriore > Schermata di blocco >
Schermo disattivato

28

Riproduzione dei file multimediali

SCEGLI LA TUA MODALITA

Premere il pulsante M per entrare in Registrazione>
Playback> Impostazione.

La modalita video verra selezionata automaticamente

all'accensione.

RIPRODUZIONE
F >> telecamera Anteriore R >> telecamera Posteriore

Nomal

Nomal

POPUP :

> Registrazione automatica in 30s nessuna azione

> premere a lungo UP ( SU ) per attivare il WiFi

> Premere brevemente UP ( SU ) per bloccare il video

> Premere brevemente DOWN ( GIU ) per catturare un
movimento

> premere a lungo Premere a lungo DOWN ( GIU ) per
interrompere/riprodurre la registrazione



Riproduzione dei file multimediali
O —
RIPRODUZIONE

Premi brevemente il pulsante M per vedere i tuoi record.

Quando selezioni un record > premi a lungo il pulsante M
per 3s per modificare i tuoi record.

D i A o B

DeleteCurent DeleteAll Lock Unlock

okl

POP-UP: Il video bloccato urgente verra creato dalla
telecamera rilevata da una collisione o vibrazione ( sensore
G acceso ).

Non pud essere un recupero automatico ma solo un
formato per salvare il momento importante.

Seleziona Blocca video per sbloccare ed eliminare

E possibile disattivare il sensore G per evitare record
bloccati

29

Personalizzazione dell' F7N

IMPOSTAZIONI

Premere brevemente per inserire il menu Impostazioni

Risoluzione

Audio

Timbro data

Registrazione in loop

Sensore G

Affaticamento alla guida

Timbro di velocita

Timbro GPS

O

<=

Loop Rrcording

oK

L

cessomp W]

> @30FPS 2160P
> @60FPS 1440P
> @120FPS 1080P

> registrazione audio
Attivato / Disattivato

> timbro Attivato /
Disattivato

>1/3/5 minuti

> Disattivato / basso / medio
/ alto

> Verra effettuato un
promemoria durante 1h / 2h
/3h / 4h / Disattivato

> timbro Attivato /
Disattivato
> timbro Attivato /
Disattivato



Personalizzazione dell' F7N

e — |

IMPOSTAZIONI
Pagina successiva

Q

SpeedUnits  GPSinfo.

@

WiFi

Unita di velocita

Informazioni GPS

Cam Flip posteriore

Mirror Flip

APP

WiFi

Lingua

Formato orario

30

@A

RearcamFlip Mirror Fiip

®0K

Language  TimeFormat W|

>KMH / MPH

>Visualizza la potenza del
segnale GPS

>verticale Capovolgi la
tua vista posteriore

>orizzontale Capovolgi la
vista frontale

>il codice QR per I' app
Redtiger

>WiFi Attivato /
Disattivato

>scegli la lingua che
preferisci

>12h/24h

Personalizzazione dell' F7N

e ——————

IMPOSTAZIONI
Pagina successiva

©

Date/Time TimeZone

% m

3/4 ClickTone  Screen.

Data / ora
Fuso orario

Ora legale

Frequenza
Fare clic su Tono

Salvaschermo

Modalita di parcheggio

Formato-Promemoria

O o=

ST

a

Frequency

Parking.. Formatre.

>aggiornato con gps
>scegli il tuo fuso orario

>ora legale Attivato /
Disattivato

> 60HZ / 50HZ
> Attivato / Mute

> lo schermo si spengono
dopo 10s / 20s / 2mins

> G-sensor / Time-Lapse

> Ricorda di cancellare i dati
/ Richiedere la formattazione



Personalizzazione dell' F7N
O — 1
IMPOSTAZIONI

Pagina successiva

“® ©

Format  Cardspeed DefaultSetting Version

Formato scheda SD > cancella i dati della

scheda SD

velocita della scheda > Rilevamento velocita della

scheda
Impostazione predefinita > ripristina tutte le
impostazioni

Versione > versione del software

POP-UP: Per un'esperienza di utilizzo pulita, fluida e
confortevole, ti suggeriamo di formattare la tua scheda SD
una volta al mese.

31

Modalita di parcheggio ( opzionale )
e — |
PREPARA IL TUO HARDWIRE KIT
Dal momento che abbiamo considerato che alcuni clienti
non hanno bisogno della modalita di parcheggio, non
c'@ alcun kit hardwire incluso nei pacchetti. Puoi fare
riferimento a questa linea di parole per contattarci per
ottenere un kit di cablaggio gratuito.

CONOSCERE IL TUO HARDWIRE KIT

Caratteristiche :

> protezione bassa tensione
> Multi potenza in ingresso
> compatibilita universale

> Lunghezza: 11.5ft

:1 B* mﬂ
‘:ll}:l} ,:[l

:& D=

ATTENZIONE: La connessione errata potrebbe
disabilitare la protezione della tensione e
danneggiare l'auto .



Modalita di parcheggio ( opzionale )
e —
INSTALLARE IL KIT HARDWIRE

Filo rosso >>ACC >>> spegnere
Filo giallo >> B+ lungo I auto
Filo nero >> Messa a terra, >>> non si spegne
ad esempio vite mai
+
Engine key

fuse Adaptive Accessory cods (red)
Cruise Control
e

Battery cord (yellow)

Earth cord (black)

Connect to metal part of the fuse
box (Negative pole of power supply)

POP-UP: Di solito & possibile trovare la scatola dei fusibili
sotto il bagagliaio o il dispositivo di sterzo.

E possibile tagliare la testa dei fili e collegarla direttamente
al fusibile se i tuoi fusibili sono piccoli.

Sie kénnen den Kopf der Dréhte abschneiden und ihn direkt
an lhre Sicherung anschlieBen, wenn lhre Sicherungen klein
sind.

32

Modalita di parcheggio ( opzionale )
e ——— ———— |
SELEZIONA LA MODALITA DI PARCHEGGIO

Accedi alla modalita di parcheggio nelle impostazioni .

Impostazione >> modalita di parcheggio
>> Disattivato / G-sensor / Time-Lapse 12h / Time-Lapse
24h / Time-Lapse 48h

G-SENSOR ( SENSORE G )

> Auto spenta

> pop-up " ACC disconnesso "

> Collisione o vibrazione da rilevare

> Verra creato un record Unerasable nello spazio Di blocco.

TIME-LAPSE

> Selezionare 12h / 24h / 48h

> Il record verra creato in 1 fps durante il tempo di
parcheggio.

> 1 min = reale 12 min

> Collisione o vibrazione da rilevare

> Verra creato un record Unerasable nello spazio Di blocco .

POP-UP: 1 fps = 1 immagine per 1 secondo.
Il sensore G potrebbe essere attivato dalla zona di
decelerazione.



Modalita di parcheggio ( opzionale ) Modalita di parcheggio ( opzionale )

[ — _— ————
INSTALLAZIONE ERRATA PARTICOLARE CONNESSIONE ERRATA
Connessioneq Guida Parcheggio Connessioneq Guida Parcheggio
== ACC =B+
B+ attivato Modalita di  Giusto B+ attivato Sempre attivoq
- Terra parcheggio - Terra
No Connessione  disattivato  disattivato ~ Sbagliato > La telecamera eseguira normalmente modalita di
R parcheggio, ma la batteria dell'auto si esaurira con questa
connessione.
— ACC > Il Modalita di parcheggio funzionera normalmente in stato
ACC SRE disattivato  Sbagliato di spegnimento dello schermo. A meno che non ci sia una
— Terta collisione o una vibrazione innescata G-Sensor.
> Si prega di verificare se la telecamera funziona dopo 15
-—p minuti la macchina é spenta.
ACC disattivato ~ disattivato ~ Sbagliato

=== No Connessione

== No Connessione
Qualsiasi potenza disattivato  disattivato ~ Sbagliato
— Terra

— Ry

ACC attivato disattivato Sbagliato
= Terra
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Connettiti all' app Redtiger

SCARICARE L' APP

1. Scaricare la nostra App da:
https://www.redtigercam.com/pages/app
2.Scansionare il codice QR dal tuo F7N

3.Scaricare da Apple APP Store o Google Play Store

Teletrasporto al funzionamento WiFi:
https://youtu.be/_NgPEb_G14c
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Connettiti all' app Redtiger
S ——

COLLEGARE ILTUO F7N

Password WiFi: 12345678

> connettiti solo questa volta

POP-UP: Questo per evitare la connessione in serie tra diversi
dispositivi.

Alcuni dispositivi potrebbero richiedere che il software
contenga virus, & possibile eseguire l'installazione come
amministratore per scaricare |'app.



Connettiti all' app Redtiger Connettiti all' app Redtiger
e — | e —
GODITI IL CONTROLLO REMOTO PARTICOLARE CONNESSIONE ERRATA

> invertimento orizzontale
——————— z

= 7 = e - ° -~-
< 7N stofass04e) > Visualizzazione a < Comera sotngs < CameraSetings
schermo intero o
Voo Watermark L]
Sound Recarding L]
> Anteriore /Posteriore Wsn
Interruttore di Loop Record Optons
- visualizzazione Speedunt
wm “ Vicoa wistermark L)
V- — g Mode ekt o)
Cotsn S
> velocita in tempo reale e
0 prsm——
¥ > Informazioni GPS WeFiName
08
> Riproduzione
> iniziare / Formars0 oot
interrompere la e
AN e r—

registrazione \™ > ) )
> scattare foto
> Impostazioni > apprezzato la maggior parte delle funzioni sul tuo

telefono

()
~~
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Lettore GPS ( PC)

O —
SCARICA GPS LETTORE

Scarica il nostro GPS lettore dal sito web:
https://www.redtigercam.com/pages/gps-player

Trascina nel lettore GPS

Trasferisci il tuo record
sul computer

8=
1
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Lettore GPS ( PC)
e — |
USA ILTUO LETTORE GPS

1 Traccia del filmato

| S—

File'Name' Flles

L s

Scegli di vedere la tua vista anteriore
/ posteriore

Visualizza la tua velocita e posizione
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Lettore GPS ( PC)
e —
USA ILTUO LETTORE GPS

Guardare anteriore e posteriore allo stesso tempo

Tacklinking .

AutoPlay Next

E Poste! riore\
Anteriore\ h

Cartella
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Montare la dashcamera Manutenzione
[ I — | e — |

COME MONTARE LA telecamera MANTIENI ILTUO CAMEAR

Non collegare e scollegare direttamente il cavo o la scheda
SD, eseguire le operazioni correlate dopo lo spegnimento
della telecamera.

Non ti incoraggiamo a collegare la tua telecamera con altri
kit di cavi rigidi, ma se insisti a farlo, dai un'occhiata a quelli
inferiori a 6 V e superiori a 2,5 A.

Non esporre al sole per lungo tempo & il migliore, la
telecamera si riscalda durante il suo funzionamento,
qualsiasi danno da alta temperatura verra aggiunto a 1
anno di garanzia di sostituzione gratuita

Teletrasporto a F7N e montaggio a camma posteriore:
> https://youtu.be/dS1YN7Zry0
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Problemi
e ——
LA CONNESSIONE WIFI DIVENTA WRONNG

Prep della c

> Dati mobili / VPN & disattivato

> 16 ft vicino al tuo F7N

> 3-5 metri di distanza effettiva

> Consentita solo la connessione a 1 dispositivo

Awviso di connessione
> password WiFi: 12345678
> Connetti solo questa volta

ALTRI PROBLEMI

Non entra in modalita di parcheggio

> & necessario un kit Hardwire

> pop-up "ACC disconnesso", quindi

entra automaticamente in modalita di parcheggio.
> Luce blu accesa + Flash luminoso rosso

Telecamera sempre accesa dopo I'auto abbassata

> Collegamento errato del filo rosso e del filo giallo

> Si prega di collegare il filo rosso con il fusibile di
accensione

Archiviazione di massa

> Utilizzare il cavo USB con funzione di trasferimento dati,
utilizzare il cavo USB senza funzione di trasferimento .
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Problemi
e —— ——— |
ALTRI PROBLEMI

Risoluzione dello schermo
> 4k = 2160P = 3840 * 2160
> 2k = 1440P=2560*1440

non puo sentire
> telecamera potrebbe funzionare -4°F - 150°F

HAI RICEVUTO LA telecamera MORTA?

Utilizzare il cavo USB per collegare la telecamera al
computer e verificare se lo schermo si accende .

> In caso contrario, si prega di scollegare la scheda SD e
utilizzare un "pin" e premere il pulsante Reset nella parte
inferiore della telecamera .

> Ricollegare la telecamera e premerlo. (')



Problemi
e — |
SOLUZIONE DEFINITIVA

> utilizzare diversi modi di ricarica per vedere se la telecamera funziona.

> utilizzare un perno o un ago per premere il pulsante di ripristino nella parte inferiore della dashcam.

> scollegare ogni connessione della telecamera.

> collegare il caricabatterie micro usb per vedere se la telecamera funziona. In caso contrario, si prega di utilizzare la carica USB
personale e controllare di nuovo.

> controllare che la tua scheda SD sia U3 Class10, in caso contrario, ti preghiamo di cambiare o lasciare un messaggio a noi per
ottenerlo.

> collegare la scheda SD e vedere se la telecamera funziona, in caso contrario, scaricare il firmware piu recente per risolverlo.

Scarica il nostro firmware piu recente per aggiornare la tua macchi
https://www.redtig .com/pages/fil 1

| passaggi di aggiornamento sono:

> Scaricare il firmware sul computer.

> Copiare il firmware denominato "FWQ70A" nella directory principale della scheda SD.

> Inserire la scheda SD nella macchina, quindi inserire il cavo di alimentazione e premere brevemente il pulsante di accensione (non
spegnere |'alimentazione durante questo processo)

> Durante il processo di aggiornamento, la luce blu & sempre accesa e la luce rossa lampeggia. Al termine dell'aggiornamento, la
macchina si accendera automaticamente. Puoi fare riferimento a questo video per aggiornare: https://youtu.be/IMz1g309SPE.

> Se il metodo sopra non ha risolto il tuo problema, non esitare a contattarci e lascia I'indirizzo corrente
che & necessario se la telecamera deve essere sostituita in seguito.

> Questa soluzione potrebbe avere a che fare con piis problemi > non si de > riavvia > errore
della scheda SD > non & possibile ripristinare i > non & possibile riprodurre
LI )
N’
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Servizio clienti
e — |

PAROLE DAL CUORE

Poiché i nostri prodotti sono legati alla sicurezza dei clienti, ci impegniamo per la qualita del prodotto e I' alta qualita post-vendita,
vogliamo ottenere la migliore qualita del prodotto.

In considerazione del fatto che nessun prodotto & |mpeccablle crediamo sinceramente che la vera misura del carattere dell'azienda sia
cio che fa * dopo * il suo prodotto non soddisfa le asp ive, ci dispi per quei clienti, ma profondamente grati per loro di renderci
un altro passo vicino al tuo marchio di post-marcatore auto-mobile pit affidabile.

Siamo disposti a fornire 1 mese di reso gratuito per il tuo prodotto. 1 anno di garanzia limitata e supporto tecnico a vita. Il tuo prodotto
& garantito per essere privo di difetti nei materiali e nei prodotti dalla data di acquisto. Inoltre, puoi anche scambiare il tuo prodotto di 1
anno con un prezzo scontato contattandoci online.

E’ un vero piacere ascoltare i tuoi consigli e prenderemo il tuo problema da qui.

Team di assistenza clienti Redtiger.

E-mail

Dash Cam Specchietto . . L . .

E-mail: support@redtigercam.com Servizio telefonico clienti: ’Dﬁ |Ok#40] E]‘%%NEJ

Mini Dash Cam +1888 966 8028 "®${ e 'S : =

E-mail: help@redtigercam.com Giorno lavorativo, lun - ven Fg&’@ P ]ﬁ’ 15 ¢

Cooperazione commerciale o altri e-mail: 6:00-12:00, 13:00-20:00 [= Ef T [Eefs

contact@redtigercam.com EST(GMT-4) WHATS FACE LINE
APP BOOK
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Informazioni sul prodotto

O —
INFORMAZIONI DI BASE DELLA telecamera

Modello

Display
Alimentazione
Apertura

Batteria

Formato video
Registrazione in loop

Metodo di registrazione

Vista schermo

Risoluzione

GPS

Audio

43

>F7N

> IPS da 3,16 pollici

> 12V /24V

>1,5

> Super condensatore

> Video:MP4 Immagine fissa: JPG
>1/3/5 minuti

> Registrazione normale / Registrazione di
emergenza

> Vista anteriore e posteriore / Vista
anteriore /Vista posteriore

> anteriore 3840 * 2160P, anteriore 2560
* 1440P anteriore 2160P + posteriore
1080P, anteriore 1440P + posteriore1080P
>Si

> Supporta la registrazione
e la riproduzione del suono

G-sensor
Micro SD scheda

Registrazione di foto

La temperature

Periodo di garanzia

> 3 Axis G-sensor
> Micro SD 32GB-256GB

> Corpo principale /Vetrina/
Computer/Smartphone

> -4°F-150°F

>1anno
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Redtiger

Always go-to dash cam

Riguardo a noi

In un' era di interconnessione automobilistica, tutto cid che riguarda il viaggio
del fascino & alla portata degli occhi.

Prodotto e servizio sono il fondamento di Redtiger. Abbiamo un team di
ricerca e sviluppo esperto di " esperti di guida autonoma pro capite ".
Sulla base delle esigenze personali degli utenti, utilizziamo la tecnologia per
guidare l'innovazione dei prodotti.

In futuro, continueremo a esplorare i confini della tecnologia per aprire una
visione piu ampia per la guida.



Inhalt
e e s |

Lernen Sie lhr F7N kennen 46
F7N Elektrowerkzeuge 47
Einrichten Ihrer Kamera 48
Wiedergeben Ihrer Medien 49
Anpassen lhrer F7N 50
Parkmodus (optional) 52
Verbinden mit der Redtiger-App 55
GPS-Spieler (PC) 57
Montage lhres F7N 60
Wartung 60
Stérungsbeseitigung 61
Kundenbetreuung 63
Informationen zum Produkt 64

F7N-Redtiger



Lernen Sie Ihr F7N kennen F7N Elektrowerkzeuge
e e — |

1. Bildschirm 3. UP/ WIF|-Taste
2. GPS-Montage 4. Modus/Bestatigungstaste
10. Statuslampe 5. Down/ Taste

6. Power-Taste (I)

7. Micro SD™-Kartensteckplatz
12. Linse

46



Lernen Sie lhr F7N kennen
e e — |

8.AV-Eingang

9. USB-Steckplatz

11. Reset-Taste

47

F7N Elektrowerkzeuge

1. Autoladegerat .):,
(kein Batterieschutz)
SEHEN SIE SEITE 5

2. Festverdrahtungssatz
(Parkmodus erforderlich)
(Aufpreis)



Einrichten lhrer Kamera
e — |
EINLEITUNG ZU F7N

Zuverldssige Dashcam, die jede lhrer Fahrten bewacht.

AKTUALISIEREN DER SOFTWARE IHRER KAMERA

Um die neuesten Funktionen und die beste Leistung Ihrer
Kamera zu erhalten, stellen Sie sicher, dass sie die aktuellste
Software verwendet.

1. Besuchen Sie https://www.redtigercam.com/pages/
firmware-1/update.

2. Leitfaden zur Aktualisierung

POP-UP: Halten Sie Ihre SD-Karte in gutem Zustand, indem
Sie Sie sie regelmaBig neu formatieren. Dies |&scht alle Ihre
Medien, weshalb Sie sie vorher sichern miissten.

1. Driicken Sie die Taste M und gehen Sie zu Einstellungen.
2. Driicken Sie die Taste UP > Format > OK

WARNUNG: Dieses Produkt ist nur fiir
Gleichstrom 12v / 24v.
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Einrichten lhrer Kamera
—_————— ————
SD-KARTE

Setzen Sie die SD-Karte bei ausgeschalteter Kamera in den
Kartensteckplatz ein, wobei sich das Etikett der Riickseite
der Kamera zuwendet.

Sie kdnnen die Karte auswerfen, indem Sie sie mit dem
Fingernagel in den Steckplatz driicken.

SD-KARTE

VERKABELUNG

SchlieBen Sie Ihre Kamera mit dem mitgelieferten Kabel
fiirs Autoladegerat an das Autoladegerét an.

SD-KARTE

Zum Speichern lhrer Videos und Fotos bendtigen Sie
eine Micro-SD-Karte (separat erhéltlich). Verwenden Sie
eine SD™-Karte der U3 Klasse 10, weil Ihre Kamera sonst
nicht richtig funktionieren kann. SD-Karten kénnen sich
mit der Zeit abnutzen und so die Fahigkeit der Kamera
zur Speicherung lhrer Medien beeintrachtigen. Ersetzen
Sie eine altere Karte durch eine neue, wenn Sie Probleme
haben.

POP-UP: Sie mochten wissen, welche Softwareversion Sie
verwenden?

Hier erfahren Sie es.

1. Driicken Sie die Taste M und gehen Sie zu Einstellungen.
2. Driicken Sie die Taste UP> Version



Einrichten lhrer Kamera

EINSCHALTEN
Driicken Sie (!) kurz die Taste, um Ihre F7N einzuschalten.

b ) 0 o=@

AUSSCHALTEN

Halten Sie U_) die Taste fiir 3 Sekunden gedriickt, um die
Kamera auszuschalten.

POP-UP:

Kurz driicken () > Vorder- und Riickansicht > Nur
Vorderseite > Nur Riickseite > Bildschirm sperren >
Bildschirm aus
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Wiedergeben Ihrer Medien

WAHLEN SIE IHREN MODUS

Driicken Sie die Taste M, um zu erreichen: Aufnahme>Wie
dergabe>Einstellung.

Der Videomodus wird beim Einschalten automatisch
ausgewahlt.

WIEDERGABE
F >> Frontkamera R >> Riickfahrkamera

Nomal

Nomal

POP-UP:

> Automatische Aufnahme bei keiner Aktion fir 30
Sekunden

> Langes Driicken von UP zum Einschalten von WiFi

> Kurzes Driicken von UP zum Sperren des Videos

> Kurzes Driicken von DOWN zum Erfassen einer
Bewegung

> Langes Driicken von DOWN zum Stoppen/Abspielen der
Aufnahme



Wiedergeben lhrer Medien
e —
WIEDERGABE

Driicken Sie kurz die Taste M, um lhre Aufnahmen zu sehen.

Wenn Sie eine Aufnahme auswéhlen > die Taste M fiir
3 Sekunden driicken, kénnen sie Ihre Aufzeichnungen
bearbeiten.

POP-UP: Das Video wird dringend gesperrt, wenn die
Kamera eine Kollision oder Erschiitterung spiirt (G-Sensor
eingeschaltet).

Es kann nicht automatisch wiederhergestellt, sondern nur
formatiert werden, um den wichtigen Moment zu speichern.
Wahlen Sie Lock Video, um das Video zu entsperren und zu
|6schen.

Sie kénnen den G-Sensor ausschalten, um die Sperre einer
Aufzeichnung zu vermeiden.
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Anpassen lhres F7N

EINSTELLUNGEN

Kurz driicken, um das Einstellungen-Menii aufzurufen

Auflésung

Ton

Datumsstempel
Loop-Aufnahme

G-Sensor

Fahren bei Ubermiidung

Geschwindigkeitsstempel

GPS-Stempel

Ps Stamp

> 2160P @30FPS
> 1440P @60FPS
> 1080P @120FPS

> Tonaufzeichnung ON /
OFF

> Stempel ON / OFF
>1/3/5Min.
> Off / niedrig / mittel / hoch

> Eine Erinnerung wird
gemacht wihrend
1h/2h/3h/4h/ off

> Stempel ON / OFF
> Stempel ON / OFF



Anpassen lhres F7N
e —
EINSTELLUNGEN

Naéchste Seite

a

Rearcamflip ~Mirror Fiip

® o

WiFi Language TimeFormat W|

Geschwindigkeitseinheiten  >KMH / MPH

Informazioni GPS > Anzeige der
GPS-Signalstarke

Riickfahrkamera Flip > Vertikale Flip lhrer
Riickansicht

Spiegel Flip > horizontale Flip Ihrer
Vorderansicht

APP > Ein QR-Code fiir die
Redtiger-App

WiFi > WiFi ON / OFF

Sprache > Auswihl Ihrer

bevorzugten Sprache

Zeitformat >12h / 24h
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Anpassen lhres F7N

e —————————

EINSTELLUNGEN
Néchste Seite

Date/Time TimeZone

@ =

3/4 ClickTone  Screen.

Datum / Uhrzeit
Zeitzone

DST

Frequenz

Klick auf Ton

Bildschirmschoner

Parkmodus

Format-Erinnerung

Frequency

Parking.. Formatre

> Aktualisieren mit GPS
> Auswahl lhrer Zeitzone
> Sommerzeit EIN / AUS
> 60HZ / 50HZ

> ON/ Stumm

> Bildschirm geht nach 10
s/20s/2min aus

> G-Sensor / Zeitraffer
> Erinnerung an die

Léschung der Daten /
Meldung zur Formatierung



Anpassen lhres F7N
B — |
EINSTELLUNGEN

Naéchste Seite

“® ©

Format  Cardspeed DefaultSetting Version

SD-Karten Format > SD-Kartendaten |I6schen

Kartengeschwindigkeit

Standardeinstellung > Alle Einstellungen

zurlicksetzen

Version > Software-Version

POP-UP: Fiir eine saubere, reibungslose und komfortable
Nutzungserfahrung zu gewahrleisten, empfehlen wir lhnen,
lhre SD-Karte einmal im Monat zu formatieren.
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> Kartengeschwindigkeitserkennung

Parkmodus (optional)
e — |
BEREITEN SIE IHREN FESTVERDRAHTUNGSSATZ VOR
Da wir davon ausgehen, dass einige Kunden
den Parkmodus nicht benétigen, gibt es keinen
Festverdrahtungssatz in lhren Paketen. Sie kénnen sich
mit dieser Zeile an uns wenden, um einen kostenlosen
Festverdrahtungssatz zu erhalten.

KENNENLERNEN IHRES FESTVERDRAHTUNGSSATZES

Merkmale:

> Niederspannungsschutz
> Multi-Eingangsleistung

> Universelle Kompatibilitat
> Lange: 11.5 FuB

WARNUNG: Ein falscher Anschluss kann den
Spannungsschutz deaktivieren und lhr Fahrzeug
beschadigen.



Parkmodus (optional)
e —
INSTALLIEREN SIE IHREN FESTVERDRAHTUNGSSATZ

Rotes Kabel ~ >>ACC
Gelbes Kabel >>B+

>>> Strom aus
entlang des

Schwarzes >> Erdungsleitung  Fahrzeugs
Kabel >>> Strom nie
ausmai
L
Engine key

fuse Adaptive Accessory cods (red)
Cruise Gontrol

Battery cord (yellow)

Earth cord (black)

battery : "' Connect to metal part of the fuse
box (Negative pole of power supply)

Parkmodus (optional)
e —
PARKMODUS WAHLEN

Parkmodus in Einstellungen erreichen
Einstellung >> Parkmodus

>> Aus / G-Sensor / Zeitraffer 12h / Zeitraffer 24h /
Zeitraffer 48h

G-SENSOR

> Auto off

> "ACC nicht angeschlossen” pop-u|

> Kollisionen oder Vibrationen werden erkannt

> Es I\Imird ein nicht |6schbarer Datensatz im Sperrbereich
erstellt.

ZEITRAFFER

> Wihlen Sie 12h / 24h/ 48h

> Eine Aufzeichnung wird in 1 fps wahrend lhrer Parkzeit
erstellt.

> 1 Minute = tatsachlich 12 Minuten

> Kollisionen oder Vibrationen werden erkannt

> Esl]/vird ein nicht I6schbarer Datensatz im Sperrbereich
erstellt.

POP-UP: Normalerweise finden Sie Ihren Sicherungsk d
unter dem Kofferraum oder der Lenkvorrichtung.

53

POP-UP: 1 fps = 1 Bild wahrend 1 Sekunde.
Der G-Sensor kann durch eine Verzégerungszone aktiviert
werden.



Parkmodus (optional)
e — |
FALSCH INSTALLIERT

Verbindung Fahren Parken

== ACC
B+ ON Parkmodus  Richtig
=== ERDE

== ACC
No Verbindung OFF OFF Falsch
=== ERDE

== ACC
ACC ON OFF Falsch
=== ERDE

-—p
ACC OFF OFF Falsch
=== No Verbindung

== No Verbindung

Jede Leistung OFF OFF Falsch
=== ERDE
= B+

ACC ON OFF Falsch
=== ERDE
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Parkmodus (optional)
O — 1
BESTIMMTE FALSCHE VERBINDUNG

Verbindung Fahren Parken
== B+

B+ ON Immer Ein
= ERDE

> Die Kamera wird den Parkmodus normal ausfiihren, aber
lhre Autobatterie wird bei dieser Verbindung entladen
werden.

> Der Parkmodus funktioniert bei ausgeschaltetem Bildschirm
normal. Es sei denn, es gibt eine Kollision oder Erschiitterung,
die den G-Sensor auslést.

> Uberpriifen Sie bitte, ob Ihre Kamera funktioniert, nach 15
Minuten nachdem lhr Auto ausgeschaltet ist.



Verbindung mit der Redtiger-App Verbindung mit der Redtiger-App
e ——— ———— |

APP HERUNTERLADEN WiFi-Passwort: 12345678

1. Laden Sie unsere App herunter unter:
https://www.redtigercam.com/pages/app °
2. Scannen Sie den QR-Code von lhrem F7N

3. Herunterladen aus dem Apple APP Store oder Google
Play Store Wi-Fi

= - WiFi-Passwort: 12345678

Teleport zum WiFi-Betrieb: > Nur dieses Mal verbinden

https://youtu.be/_NgPEb_G14c

POP-UP: Dies dient der Vermeidung von Reihenschaltungen
zwischen verschiedenen Geréaten.

Einige Gerate melden méglicherweise, dass die Software
einen Virus enthalt. Sie kénnen die Installation als
Administrator ausfiihren, um die App herunterzuladen.
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Verbindung mit der Redtiger-App
e — |

FERNBEDIENUNG GENIESSEN

56

—

o
< FIN-Stef32660489

wm Kl

> Horizontal Flip

> Vollbildanzeige

> F /R Ansichtsschalter
> Stumm

>Echtzeit
-Geschwindigkeit

> GPS-Informationen
> Wiedergabe

> Aufzeichnung
stoppen/starten

> Fotoaufnahme

> Einstellungen

Verbindung mit der Redtiger-App

Camra angsge

Z =)
¢

‘Sound Rocarding. L]
i .

s

< Camera Setings

Cofision Sensing

Specdunit

Time-lapo vide

Cameratanguage

> Die meisten Funktionen Ihres Handys genieBBen




GPS-Spieler (PC)
e — |
GPS-SPIELER HERUNTERLADEN

Laden Sie unseren GPS-Spieler von der Website herunter:
https://www.redtigercam.com/pages/gps-player

In den GPS Player ziehen

Ihre Aufzeichnung auf den
Computer tibertragen

8=
37 I
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GPS-Spieler (PC)
e — |
GPS-SPIELER VERWENDEN

1 Filmmaterial verfolgen

| S—

File'Name' Flles

L s

Ihre Vorder-/Riickansicht wéhlen

lhre Geschwindigkeit und Position sehen
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GPS-Spieler (PC)
e —
GPS-SPIELER HERUNTERLADEN

Vorder- und Riickansicht gleichzeitig schauen

Tacklinking

AutoPlay Next

B3
E Riick \
order N D

Ordner
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lhre Kamera montieren Wartung
[ I — | e — |
WIE SIE IHRE KAMERA MONTIEREN KONNEN IHRE KAMERA WARTEN

Stecken Sie das Kabel oder die SD-Karte nicht direkt ein
und aus, sondern fiihren Sie die entsprechenden Vorgénge
erst nach der Ausschaltung der Kamera.

Wir raten Ihnen davon ab, lhre Kamera mit anderen
Festverdrahtungssétzen zu verbinden, aber wenn Sie
darauf bestehen, sollten Sie nach den Modellen weniger
als 6 V und mehr als 2,5 A suchen.

Setzen Sie die Kamera am besten nicht fiir langere Zeit
der Sonne aus, da sie sich wahrend des Betriebs erhitzt.
Alle Beschadigungen durch hohe Temperatur werden der
1-Jahr-Garantie fiir kostenlosen Ersatz hinzugefiigt.

Teleport zu F7N & Montage der Riickfahrkamera:
> https://youtu.be/dS1YN7Zry0
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Stérungsbeseitigung
O  — 1
WIFI-VERBINDUNG GEHT SCHIEF

Verbindung vorbereiten

> Mobile Daten / VPN ist ausgeschaltet
> 16 FuB in der Nahe lhres F7N

> 3-5 Meter effektive Entfernung

> Nur Verbindung mit 1 Gerét erlaubt

Hinweis zur Verbindung
> WiFi-Passwort: 12345678
> Nur dieses Mal verbinden

ANDERE PROBLEME

Parkmodus nicht erreichbar

> Festverdrahtungssatz erforderlich

> Die Meldung "ACC nicht verbunden" erscheint, dann
wird der Parkmodus automatisch aktiviert.

> Blaues Licht an + Rotes Licht blinkt

Kamera ist immer in Betrieb, nachdem das Auto abgestellt
wurde

> Falscher Anschluss des roten und gelben Kabels

> Bitte verbinden Sie das rote Kabel mit der
Ziindungssicherung

Massenspeicher

> USB-Kabel mit Datentibertragungsfunktion verwenden,
bitte USB-Kabel ohne Ubertragungsfunktion verwenden
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ANDERE PROBLEME

Bildschirmauflésung
> 4k = 2160P=3840*2160
> 2k = 1440P=2560*1440

Uberhéren
> Kamera kdnnte funktionieren -4°F- 150°F

TOTE KAMERA ERHALTEN?

Verwenden Sie ein USB-Kabel, um die Kamera mit dem
Computer zu verbinden und iiberpriifen Sie, ob der
Bildschirm eingeschaltet ist.

> Wenn nicht, ziehen Sie die SD-Karte heraus und driicken
Sie mit einem Stift die Reset-Taste an der Unterseite der
Kamera.

> SchlieBen Sie Ihre Kamera wieder an und driicken Sie ()



Stérungsbeseitigung
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ULTIMATIVE LOSUNG

> Verwenden Sie verschiedene Ladeverfahren, um zu sehen, ob die Kamera funktioniert.

> Verwenden Sie einen Stift oder eine Nadel, um die Taste an der Unterseite der Dashcam zu driicken.

> Ziehen Sie alle Anschliisse der Kamera ab.

> SchlieBen Sie das Mikro-USB-Ladegerat an, um zu sehen, ob die Kamera funktioniert. Wenn nicht, verwenden Sie bitte lhr persénliches
USB-Ladegerit und iiberpriifen Sie es erneut.

> Priifen Sie, ob lhre SD-Karte U3 der Klasse 10 ist, wenn nicht, wechseln Sie sie bitte aus oder senden Sie uns eine Nachricht, damit wir

sie besorgen kénnen.
> Stecken Sie die SD-Karte ein und priifen Sie, ob die Kamera funktioniert. Wenn nicht, laden Sie bitte die neueste Firmware herunter,

um das Problem zu I6sen.

Bitte laden Sie unsere neueste Firmware herunter, um lhr Gerat zu aktualisieren:

https://www.redtigercam.com/pages/firmware-1

Die Schritte fiir das Upgrade sind:

> Laden Sie die Firmware auf Ihren Computer herunter.

> Kopieren Sie die Firmware mit der Bezeichnung "FWQ70A" in das Stammverzeichnis der SD-Karte.

> Legen Sie die SD-Karte in das Gerét ein, schlieBen Sie das Netzkabel an und driicken Sie kurz den Power-Taste (schalten Sie das Geréat
wahrend dieses Vorgangs nicht aus).

> Wahrend des Aktualisierungsvorgangs leuchtet das blaue Licht standig und das rote Licht blinkt. Nach Abschluss des Upgrades
schaltet sich das Gerét automatisch ein, d. h. es ist fertig. Sie kénnen sich dieses Video zum Upgrade ansehen: https://youtu.be/
IMz1g309SPE.

> Wenn die obige Methode Ihr Problem nicht gelést hat, kontaktieren Sie uns und hinterlassen Sie bitte lhre aktuelle
Adresse, die benétigt wird, wenn die Kamera spater ersetzt werden muss.
> Diese Lésung kénnte mehrere Probleme betreffen > lasst sich nicht einschalten > startet selbst neu >
SD-Kartenfehler > kann nicht automatisch wiederhergestellt werden > kann nicht wiedergegeben werden

62



Kundenbetreuung
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WORTE, DIE VON HERZEN KOMMEN

Da unsere Produkte mit der Sicherheit der Kunden verbunden sind, setzen wir uns fiir die Produktqualitét und einen hochwertigen
Kundendienst ein, um die beste Produktqualitét zu erreichen.

In Anbetracht der Tatsache, dass kein Produkt fehlerfrei ist, glauben wir aufrichtig, dass der wahre MaBstab fiir den Charakter des
Unternehmens das ist, was es tut, *nachdem* seine Produkte den Erwartungen nicht entsprechen. Es tut uns herzlich leid aber wir
sind den Kunden zutiefst dankbar, denn sie uns einen weiteren Schritt ndher zur ihrer vertrauenswiirdigen Marke fiir den automobilen
Ersatzteilmarkt machen.

Wir sind bereit, Ihr Produkt 1 Monat lang kostenlos zuriickzugeben. Noch beschrénkte Wartung fiir 1 Jahr und lebenslange technische
Unterstiitzung. Wir garantieren, dass Ihr Produkt ab dem Kaufdatum frei von Material- und Produktfehlern ist. Dariiber hinaus kénnen
Sie |hr 1-Jahr-altes Produkt zu einem vergiinstigten Preis umtauschen, indem Sie uns online kontaktieren.

Betrachten Sie das Motiv der Komplexitat fiir uns, der Einfachheit fiir andere. Es ist so ein Vergniigen, Ihren Ratschldgen zuzuhéren, und
wir werden lhr Problem von hier I6sen.

Redtiger-Kundendienst-Team

Email

Mirror Dash Cam i

Email: support@redtigercam.com Telefonische Kundenbetreuung:

Mini Dash Cam +1888 966 8028

Email: help@redtigercam.com Werktag, Mo.-Fr.

Geschéftliche Zusammenarbeit 6.00-12.00 UHR, 13.00-20.00 UHR E-MIAL WHATS FACE LINE
oder andere E-Mail: EST (GMT-4) APP BOOK

contact@redtigercam.com
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Informationen zum Produkt
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GRUNDLEGENDE INFORMATIONEN ZU IHRER KAMERA

Modell

Anzeige
Stromversorgung
Blende

Batterie
Videoformat
Loop-Aufnahme
Aufnahmeverfahren

Bildschirmansicht

Auflésung

GPS

Audio
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>F7N

> 3,16 Zoll IPS

> 12V / 24V

>1,5

> Superkondensator

> Video:MP4 Standbild: JPG

> 1/3/5Minuten

> Normale Aufnahme/Notfallaufnahme

> Vorder- und Riickansicht/Vorderansicht/
Riickansicht

> Vorderseite 3840*2160P,
Vorderseite 2560*1440P Vorderseite
2160P+Riickseite 1080P,Vorderseite
1440P+Riickseite1080P

>Ja

> Unterstiitzung von Tonaufnahme und
Wiedergabe

G-sensor
Micro SD-Karte

Foto aufnehmen

Temperatur

Garantiezeit

> 3-Achsen-G-Sensor
> Micro-SD 32 GB-256 GB

> Hauptkérperanzeige /
Computer/Smartphone

> -4°F-150°F

> 1 Jahr
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Redtiger

Always go-to dash cam

Uber uns

Im Zeitalter der Vernetzung von Autos liegt alles, was mit der Zauberreise zu
tun hat, innerhalb der Reichweite der Augen.

Produkt und Service sind das Fundament von Redtiger. Wir haben ein
kompetentes Forschungs- und Entwicklungsteam von "selbstfahrenden
Experten".Ausgehend von den persénlichen Bediirfnissen der Nutzer nutzen
wir Technologien, um Innovationen unserer Produkte voranzutreiben.

Auch in Zukunft werden wir die Grenzen der Technik erforschen, um eine
umfassendere Vision fiir das Fahren zu erméglichen.



